DSS-2
Two-Channel Digital Speed Switch

Manual 36598
WARNING
Read this entire manual and all other publications pertaining to the work to be performed before installing, operating, or servicing this equipment. Practice all plant and safety instructions and precautions. Failure to follow instructions can cause personal injury and/or property damage.

The engine, turbine, or other type of prime mover should be equipped with an overspeed shutdown device to protect against runaway or damage to the prime mover with possible personal injury, loss of life, or property damage.

The overspeed shutdown device must be totally independent of the prime mover control system. An overtemperature or overpressure shutdown device may also be needed for safety, as appropriate.

CAUTION
To prevent damage to a control system that uses an alternator or battery-charging device, make sure the charging device is turned off before disconnecting the battery from the system.

In systems where large inductive loads are switched on the DC power buss, surge impulse energy will be present due to the switching. To address surge energy affects on the control, appropriate suppression devices must be installed in the DC power buss prior to the control's power connection.

Electronic controls contain static-sensitive parts. Observe the following precautions to prevent damage to these parts.
- Discharge body static before handling the control (with power to the control turned off, contact a grounded surface and maintain contact while handling the control).
- Avoid all plastic, vinyl, and Styrofoam (except antistatic versions) around printed circuit boards.
- Do not touch the components or conductors on a printed circuit board with your hands or with conductive devices.

IMPORTANT DEFINITIONS
WARNING—indicates a potentially hazardous situation which, if not avoided, could result in death or serious injury.

CAUTION—indicates a potentially hazardous situation which, if not avoided, could result in damage to equipment.

NOTE—provides other helpful information that does not fall under the warning or caution categories.

Revisions—Text changes are indicated by a black line alongside the text.
Contents

REGULATORY COMPLIANCE ................................................................. III

ELECTROSTATIC DISCHARGE AWARENESS................................. IV

CHAPTER 1. GENERAL INFORMATION........................................... 1
  Introduction .............................................................................................. 1
  How Speed Switches Work ...................................................................... 2
    Set vs. Reset .......................................................................................... 2
    Normal vs. Reverse Relay Logic ............................................................ 2
    Autocrank ............................................................................................ 3
    Glow Plug Preheat ................................................................................. 3
  System Components .................................................................................. 3
    DSS-2 Controller .................................................................................. 3
    All-purpose Calibration Tool (ACT) ....................................................... 5

CHAPTER 2. SPECIFICATIONS ...................................................... 6
  Electrical .................................................................................................. 6
  Mechanical .............................................................................................. 6

CHAPTER 3. INSTALLATION ......................................................... 7
  DSS-2 Mounting ...................................................................................... 7
  DSS-2 Wiring ........................................................................................... 7
    Controller Pinout .................................................................................. 10
  Speed Sensor Installation ........................................................................ 11

CHAPTER 4. CALIBRATION ......................................................... 12
  Calibration Guide .................................................................................... 12
    Manual Calibration ............................................................................... 12
    Calibration with ACT ............................................................................ 12
    Speed Switch Configuration ................................................................. 14
    Figure 4. Typical Speed Switch Installation .......................................... 14
    Manual Calibration ............................................................................... 15
    Speed Switch Calibration Using ACT ................................................... 15
    Normal Operation vs. Reverse Operation ............................................. 16
    Reset Mode: Auto/Manual/Latch .......................................................... 16
    Speed Switch Options .......................................................................... 16
    Speed Switch Options .......................................................................... 17
  Autocrank Configuration ....................................................................... 18
    Manual Calibration ............................................................................... 19
    Autocrank Calibration Using ACT ....................................................... 20
    Enabling Autocrank .............................................................................. 20
    Autocrank Options ............................................................................... 21
  Glow Plug Controller Configuration ......................................................... 21
    Manual Calibration ............................................................................... 21
    Glow Plug Controller Adjustment Using ACT ..................................... 23
    Enabling Glow Plug Control ................................................................. 23
    Pre-Heat Time ....................................................................................... 24
  Engine Protection Switch Configuration ................................................. 24
  Completing Wizard Configuration .......................................................... 25
Contents (cont’d.)

CHAPTER 5. ACT OPERATION.................................................................26
ACT Installation .................................................................................26
ACT Kit Contents ................................................................................26
Set-up Requirements .........................................................................26
Hardware Set-up ................................................................................26
Software Set-Up ..................................................................................27
Basic ACT Operation ..........................................................................28
Running the ACT Software ...............................................................28
Progress Display Screen .................................................................28
Moving Around the Software .............................................................29
ACT Menus & Options ........................................................................29
ACT Menu Structure ..........................................................................29
File Menu ............................................................................................30
Purpose ...............................................................................................30
Save DSS-2 Cal to File ........................................................................30
View Cal File Comments ....................................................................31
View Text File ......................................................................................32
Convert Commands ...........................................................................32
Convert DSS-2 Cal to Text .................................................................32
Convert Cal File to Text .....................................................................33
Convert Cal File to Strategy ...............................................................33
Calibrate Menu ..................................................................................33
Change DSS-2 Calibration .................................................................33
Calibration Categories ........................................................................35
List of Parameters ..............................................................................36
Download Cal File to DSS-2 .............................................................39
Compare DSS-2 Cal to File Cal ............................................................40
Change DSS-2 Password ....................................................................41
DSS-2 Calibration Wizard .................................................................43
Monitor Menu ......................................................................................44
Parameter View ..................................................................................44
Parameter Plot ....................................................................................45
Display Faults .......................................................................................46
Control Strategy ................................................................................47
Configure Menu ..................................................................................48
Configure Serial Port .........................................................................48
Help Menu ..........................................................................................49
Help Topics ........................................................................................49
About ACT ........................................................................................49
User Manuals .....................................................................................49

CHAPTER 6. TROUBLESHOOTING..................................................50
General Checklist ..............................................................................50
Fault Codes ........................................................................................50
Glossary of Technical Terms .............................................................52

CHAPTER 7. SERVICE OPTIONS ..................................................53
Product Service Options ......................................................................53
Returning Equipment for Repair .......................................................54
Replacement Parts ..............................................................................55
How to Contact Woodward ...............................................................55
Engineering Services ..........................................................................56
Technical Assistance .........................................................................57
Regulatory Compliance

European Compliance for CE Marking

**EMC Directive**

**Electromagnetic Compatibility**
Testing was performed to ISO/EN 14982:1998 and EN 13309:2000 standards.

Evaluations, other than specific testing, were performed to cover:
- EN 12895:2000
- EN 61000-6-2:2001
- EN 61000-6-4:2001

Testing to EN 14982:1998 and application specific installation requirements cover evaluations. (See Chapter 1 of this manual for intended usage of this unit.)

**EMC Limitations**
All cabling for these controllers is limited to less than 3m (9.84').
Power cabling is limited to less than 10m (32.8') in total length.
See wiring diagrams for specific cable types required.

**Declaration of Conformity**
The official Declaration of Conformity is available upon request. Please see the “How to Contact Woodward” section in Chapter 7 to request a copy.
Electrostatic Discharge Awareness

All electronic equipment is static-sensitive, some components more than others. To protect these components from static damage, you must take special precautions to minimize or eliminate electrostatic discharges.

Follow these precautions when working with or near the control.

1. Before doing maintenance on the electronic control, discharge the static electricity on your body to ground by touching and holding a grounded metal object (pipes, cabinets, equipment, etc.).

2. Avoid the build-up of static electricity on your body by not wearing clothing made of synthetic materials. Wear cotton or cotton-blend materials as much as possible because these do not store static electric charges as much as synthetics.

3. Keep plastic, vinyl, and Styrofoam materials (such as plastic or Styrofoam cups, cup holders, cigarette packages, cellophane wrappers, vinyl books or folders, plastic bottles, and plastic ash trays) away from the control, the modules, and the work area as much as possible.

4. Do not remove the printed circuit board (PCB) from the control cabinet unless absolutely necessary. If you must remove the PCB from the control cabinet, follow these precautions:
   
   • Do not touch any part of the PCB except the edges.

   • Do not touch the electrical conductors, the connectors, or the components with conductive devices or with your hands.

   • When replacing a PCB, keep the new PCB in the plastic antistatic protective bag it comes in until you are ready to install it. Immediately after removing the old PCB from the control cabinet, place it in the antistatic protective bag.

CAUTION
To prevent damage to electronic components caused by improper handling, read and observe the precautions in Woodward manual 82715, *Guide for Handling and Protection of Electronic Controls, Printed Circuit Boards, and Modules.*
Chapter 1.  
General Information

Introduction

DSS-2 (Digital Speed Switch, 2-Channel) is a two-channel electronic speed switch that combines the convenience of manual adjustments with the flexibility of a computer-based calibration tool. DSS-2 was designed for use on engine applications where it can perform a variety of speed related functions such as starter motor disable and engine overspeed protection. DSS-2 monitors engine rpm via a magnetic pickup (MPU) input and controls two independent relays. Once engine speed exceeds the user selected speed setpoint, the relay will go to the designated set condition. DSS-2 can also be re-configured with the ACT (All-purpose Calibration Tool) to function as an engine autocrank controller or glow plug controller.

DSS-2 has two multi-turn potentiometers for manual speed setpoint adjustment. A computer interface is provided for additional adjustments with the All-purpose Calibration Tool (ACT). Electrical connections consist of thirteen wires and utilize a Euro-style terminal strip. For most applications, DSS-2 can be connected and adjusted with simple hand tools. For more advanced features, the calibration tool provides user-friendly access. Three indicator lamps permit system monitoring and diagnosis without use of additional tools.

As shipped from the factory, DSS-2 can be manually adjusted on most applications that supply a MPU frequency of 2500 to 5000 Hz. Optionally, the user may attach the calibration tool (ACT) to gain access to a number of user-adjustable features including:

- Frequency range (200-15,000 Hz)
- Normal and reverse mode operation
- Automatic, Manual or Latched reset
- Set condition on Engine Protection (EP) switch on
- Set condition on loss of speed signal
- Set condition on Start Switch (VER) off
- Autocrank: Configure crank disconnect speed range, crank time, rest time and number of crank attempts
- Glow plug preheat

Intended Usage

The DSS-2 is intended as a sub-system for integration into construction/commercial and industrial engine systems by original equipment manufacturers and industrial plants. It is not intended for consumer or on-highway vehicles or for use by the general consumer/public. Typical applications include generator sets, compressors, construction machinery and farm vehicles.
How Speed Switches Work

The purpose of a speed switch is to monitor the speed of a rotating device, such as an internal combustion engine, and close or open a set of switch contacts when speed exceeds a threshold. Speed switches are most often used to disengage starter motors when the engine starts, and to shut down the engine should an overspeed occur. With the addition of some logic, speed switches may be applied to a number of applications. Electrical loads controlled with a speed switch include starter relays, ignition system power, indicator lamps, glow plug relays, solenoids and electro-hydraulic valves.

Set vs. Reset

Speed switches make frequent use of the terms “Set” and “Reset.” The “Reset” condition or state is that which exists when the unit is first powered up and when engine speed is below the speed threshold. Once speed rises above the threshold (set speed), the speed switch output (relay) transitions to the “Set” condition. In some cases, depending on configuration, the speed switch can return to the “Reset” condition when engine speed drops below a lower threshold (reset point), or when a manual reset switch is actuated. The speed switch may also be configured to latch a Set condition until battery power is cycled.

Normal vs. Reverse Relay Logic

A normally configured speed switch channel has the relay de-energized in the Reset condition and energized in the Set condition. It is possible to configure each channel in Reverse mode such that the relay is energized in the Reset condition and de-energized in the Set condition. This is helpful in applications such as engine crank disable where a loss of power to the DSS-2 should produce the same response as
exceeding the set engine speed. Configuring a channel in normal mode for a crank disable feature could cause overcranking if power were interrupted to the DSS-2.

**Autocrank**

The DSS-2 speed switch channels can be easily configured to provide an autocrank feature using the ACT. In this mode, applying battery voltage to the VER input will initiate the starting sequence. When this happens, the relay will be energized until either the engine starts, or a maximum crank time is exceeded. If the latter occurs, the logic will wait for a rest period before attempting to crank again. Crank Time, Rest Time and Maximum number of crank attempts are user selectable using the ACT. The rpm at which the DSS-2 assumes the engine has started, referred to as the crank disable speed, is adjustable using the multi-turn potentiometer for that channel.

**Glow Plug Preheat**

When one channel of the DSS-2 has been configured for autocrank, the user may configure the other channel as a glow plug controller. In this mode, the DSS-2 will energize the glow plug relay for a fixed period of time before engine cranking begins. The relay will remain on until the end of the crank period, or until the engine starts – whichever comes first. The glow plug relay will remain on during the rest period provided that the glow plug preheat time is longer than the rest time, if not, the glow plug relay will be turned off until the appropriate preheat delay prior to the next crank attempt. The maximum glow plug preheat time is user selectable using the ACT. The actual preheat time is adjustable between zero and the maximum using the multi-turn potentiometer for that channel.

**System Components**

The two components required to install a DSS-2 on an engine are the DSS-2 controller and magnetic pickup (MPU) speed sensor. Both components contribute to the overall performance of the system and shortcomings in either will detract from total system performance. Optionally, the All-purpose Calibration Tool (ACT) may be used to customize operation.

**DSS-2 Controller**

DSS-2 contains a powerful microcontroller that processes the signal received from the MPU sensor and compares it to the speed setpoints. Output control is accomplished by means of two independently controlled form-C relays with Common (C), Normally Closed (NC) and Normally Open (NO) contacts.

The DSS-2 controller has two multi-turn potentiometers for speed setpoint adjustment. A computer serial interface is provided for additional adjustments with the ACT.

The controller has thirteen Euro-style screw terminals for:

- *Battery Positive and Negative* (9-30 Vdc). Reverse voltage protected
- *Two form-C relays* (10A continuous). Independent Common (C), Normally Closed (NC) and Normally Open (NO) contacts are provided. DSS-2 is factory programmed for standard relay logic (relay de-energized below set speed), but may be modified with the ACT for reverse relay logic (relay energized below set speed). External diodes should be added for transient suppression with inductive loads
Magnetic Pickup (MPU) Positive and Negative (2 VAC minimum at 1000 Hz). The controller is factory programmed for 2500 to 5000 Hz. This range may be modified with the ACT to cover 200-15,000 Hz or operate in units of rpm.

Reset Switch Input (RST): A switch to battery positive switch input is provided for manual reset functions. DSS-2 is factory programmed for automatic reset at 80% of set speed, but may be modified with the ACT for manual or latched reset.

Engine Protection Switch Input (EP): A switch to battery positive switch input is provided for connection to external engine protection devices.

Verify Switch Input (VER): A switch to battery positive switch input is provided for a verify function. Activating this switch will reduce both channel set frequencies to 70% of their normal values. The VER input also functions as a Start/Stop switch input in certain modes of operation. When a channel is configured as an autocrank controller, the Verify switch is used to initiate the start sequence. If a channel uses the Verify switch as a Start Switch, removing the switch input will force the channel to a set status.

Use insulated, automotive grade wiring (minimum 18 AWG or 1 mm²) for all connections. Shielded wiring is recommended for the MPU.

The DSS-2 is equipped with three LEDs: one green and two red. All LEDs will be turned on for one second following power up as a lamp test and as an indication of normal operation.

Green LED:
The green LED is an engine status indicator and functions as follows:
  - OFF: No engine speed
  - ON: Engine speed sensed
  - Flashing: Fault present

Red LEDs:
The red LEDs are each assigned to a speed switch channel.

- When a channel is configured as a speed switch, its LED will be illuminated when the channel relay is in the Set condition.
- When a channel is configured as a glow plug controller, its LED will be illuminated when the relay is energized (glow plug ON).
- When a channel is configured as an autocrank controller, its LED will be illuminated when the relay is energized. The LED will flash rapidly during the starter rest period (relay de-energized).
Speed Sensor

DSS-2 monitors engine speed continuously using a magnetic pickup (MPU), which detects the passing of teeth on an engine driven gear (e.g., flywheel). The frequency of the voltage generated by the MPU is proportional to engine rpm.

A variety of MPU sensors are available from Woodward.

All-purpose Calibration Tool (ACT)

ACT is a PC (personal computer) based software calibration and monitoring tool. ACT is designed specifically for use with engines equipped with the DSS-2 controller. The tool can be run on any IBM compatible computer that meets the requirements listed ACT Installation in Chapter 5.

Once the DSS-2 controller has been programmed, ACT may be disconnected. The DSS-2 unit will continue to operate normally with ACT either connected or disconnected.

Woodward P/N SA-5206

CAUTION

An unsafe condition could occur with improper use of these software tools. Only trained personnel should have access to these tools.
Chapter 2. Specifications

Woodward P/N: 8800-1001

Electrical

<table>
<thead>
<tr>
<th>Power Input</th>
<th>9-30 Vdc, Reverse polarity protected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electromagnetic Compatibility</td>
<td>See Regulatory Compliance on page iii.</td>
</tr>
<tr>
<td>Operating Current:</td>
<td></td>
</tr>
<tr>
<td>Both Channels On:</td>
<td>12 V: 100 mA / 24 V: 100 mA</td>
</tr>
<tr>
<td>Both Channels Off:</td>
<td>12 V: 50 mA / 24 V: 50 mA</td>
</tr>
<tr>
<td>Relay Contact Ratings @ 28 Vdc</td>
<td>Resistive Load: 1 to 10A</td>
</tr>
<tr>
<td></td>
<td>Inductive Load: 1 to 8A</td>
</tr>
</tbody>
</table>

Mechanical

<table>
<thead>
<tr>
<th>Operating Temperature</th>
<th>-40°F to +185°F (-40°C to 85°C)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vibration</td>
<td>4 G’s from 40 to 2000 Hz</td>
</tr>
<tr>
<td>Shock</td>
<td>10 G’s @ 45 Hz</td>
</tr>
<tr>
<td>Housing</td>
<td>UV, chemical resistant. UL 94 V-O flame retardant. Encapsulated for reliability in harsh environments</td>
</tr>
<tr>
<td>Termination</td>
<td>Euro-style terminal block</td>
</tr>
<tr>
<td>Calibration</td>
<td>Manual or with PC-based All-purpose Calibration Tool / ACT [SA-5206]</td>
</tr>
<tr>
<td>Weight:</td>
<td>0.38 lbs (0.17 kg)</td>
</tr>
</tbody>
</table>

NOTE
The scope of this manual does not include selection of speed sensors or other components that Woodward offers for use with the DSS-2 system. Information is available on our website at www.woodward.com.

NOTE
The need for sub-components such as switches is application dependent. Please contact Woodward for information specific to your application.
Chapter 3.
Installation

CAUTION
Take adequate protection to ensure personal and equipment safety and follow the suggested installation sequence given below.

Refer to Figures 2 & 3 and Table 1 to install the system and subcomponents.

DSS-2 Mounting

Mount the unit in a location where the effects of vibration and temperature are within the specified range. Operating temperature: -40°F to +185°F (-40°C to +85°C); vibration: 6 G’s from 40 to 2000 Hz. (See Figure 2 for controller dimensions.)

DSS-2 Wiring

DSS-2 has thirteen Euro-style terminals for external connections. To use:

1. Loosen the terminals with a small blade screwdriver.
2. Strip wire.
3. Insert wire into terminal hole.
4. Tighten terminal with a small blade screwdriver.

Refer to Figure 3. Use proper wire gauges (18 AWG/ 1 mm² minimum). All wire insulation should be appropriate for engine applications. Terminations must be impervious to moisture to prevent shorts and corrosion.

Use of convoluted tubing, conduit, or other wire shielding is recommended to minimize the likelihood of mechanical damage to wires. Avoid routing wires near sharp edges or near locations that can cause the wires to be pinched or damaged.

Power Leads: Power leads are to be connected directly to a switched power source (i.e., battery). With both channels on, DSS-2 draws a maximum of 100 mA. Use of a slow-blow fuse is recommended in the battery (positive) wire. Electrical loads attached to the two relays should be separately fused.

MPU Wiring: Use shielded cable for MPU signal. The shield should be connected to the battery ground wire at one end only.

Output Loads: Channel 1 and Channel 2 output relays may be connected to a variety of electrical loads including starter relays, engine ignition systems, fuel shutdown solenoids, indicator lamps, hydraulic solenoid valves, etc. The current requirements of the load must be matched to the contact capability of the output relays (10A resistive load). When the output relays are connected to inductive loads (e.g. solenoids) external diodes should be added to increase contact life and for transient suppression. Electrical loads attached to the two relays should be separately fused.

Excessive resistance in the wiring will result in reduced current to the electrical load. Such increased resistance can result from too much wire length, inadequate wire gauge, or poor connections. Total wiring length—between battery power and the DSS-2 as well as between the DSS-2 and the load—must be considered.
It is important to use good quality terminations and proper crimping technique.

**Switch Inputs:** The switch inputs (VER, RST, EP) draw very little current (less than 1 mA each). The external switches should be selected for prolonged use at these low currents. One side of the switch should be connected to battery voltage and the other side connected to the DSS-2 switch input.

![Figure 2. DSS-2 Dimensions](image-url)
Table 1. Controller Wiring

<table>
<thead>
<tr>
<th>FUNCTION</th>
<th>PIN INFORMATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Battery</td>
<td>BAT(+), GND(-)</td>
</tr>
<tr>
<td>MPU Speed Signal Input</td>
<td>RPM(+), RPM(-)</td>
</tr>
<tr>
<td>Channel 1</td>
<td>C-1, NC-1, NO-1</td>
</tr>
<tr>
<td>Channel 2</td>
<td>C-2, NC-2, NO-2</td>
</tr>
<tr>
<td>Verify/Start Switch</td>
<td>VER</td>
</tr>
<tr>
<td>Reset Switch</td>
<td>RST</td>
</tr>
<tr>
<td>Engine Protection Switch</td>
<td>EP</td>
</tr>
<tr>
<td>ACT Connector</td>
<td>RCV (Pin 4), TXD (Pin 3), GND2 (Pin 1)</td>
</tr>
</tbody>
</table>

**CAUTION**

To prevent damage to the controller, make sure that it is wired in accordance with the wiring instructions and diagrams in this manual.
Controller Pinout

Use the diagram below to connect your DSS-2 controller to battery power, the mag pickup, loads, switches and ACT.

**NOTE**
All cabling for the DSS-2 controller is limited to less than 3m (9.84’). Power cabling is limited to less than 10m (32.8’) in total length. The wiring diagram below shows specific cable types required.

---

Figure 3. DSS-2 Wiring Diagram
Speed Sensor Installation

Installed opposite an engine driven gear such as the flywheel, the mag pickup (MPU) transmits a signal each time the magnetic flux path across the pole is interrupted by a gear tooth. The frequency of the AC signal generated by the MPU is proportional to the engine speed.

The mounting of the sensor unit must be rigid; excessive vibration can cause erroneous signals and unreliable performance.

MPU output voltage is affected by tooth speed and gap size between the sensor and the gear tooth. The higher the tooth speed, the higher the output voltage. Conversely, the larger the sensor gap, the lower the output voltage. In general, gap of 0.015 to 0.018" (0.38 to 0.46mm) is adequate for most engines and operating speeds. If the gap cannot be measured, it may be adequate to do the following:

1. Align a gear tooth in the center of the hole.
2. Install the MPU until the tip touches the tooth. This assumes that the hole is tapped to the full depth and no burrs exist which preclude moving the sensor all the way up to the tooth.
3. Un螺丝 the MPU approximately one-quarter to one-half turn.
4. While holding MPU position fixed, tighten lock nut.
5. Hand turn the engine one complete revolution to confirm that none of the gear teeth contact the MPU.

Connect the speed sensor to the two rpm inputs on the controller. Most sensors do not have a positive or negative side and can be connected either way. Use twisted pair shielded wire for all speed sensor wiring. The shield should be grounded at the controller only. DSS-2 requires a minimum output voltage of 2 Vac. It is recommended that the MPU output not be shared with other devices (tachometers, etc.).

The frequency of the signal coming out of the MPU is related to the engine rpm as follows:

**Frequency (Hz) = RPM x nteeth/60**

Where nteeth is the number of teeth on the gear adjacent to The MPU (usually the flywheel).

Conversely:

**RPM = frequency x 60/nteeth**

Many hand held digital multi-meters can measure signal frequency (Hz).
Chapter 4.
Calibration

Calibration Guide

This section explains the procedures for calibrating (configuring and adjusting) the various DSS-2 features to work with your application.

Each of the two DSS-2 channels can be independently configured as:

- Speed Switch (either normal or reverse acting)
- Autocrank Controller
- Glow Plug Controller

Each of these will be addressed separately.

Before proceeding, make sure you have completed the installation of all the required hardware for your system as discussed in Chapter 2.

Manual Calibration

DSS-2 is equipped with two operator-adjustable potentiometers, one for each channel. These are multi-turn potentiometers that require 20-30 turns to cover the full range of setspeeds. The potentiometers have an internal clutch to prevent damage from overturning. The function of the potentiometer will vary depending on how the DSS-2 is configured.

Calibration with ACT

ACT (All-purpose Calibration Tool) can be used to provide a wide variety of custom features to the DSS-2. Refer to Chapter 5 for general information regarding installation, connection and operation of ACT. The Calibration Wizard is the preferred approach to ACT calibration, but similar results can be obtained using the Calibrate/Change DSS-2 Calibration Menu item (see Chapter 5 for details). ACT is not required as long as the channels have been previously configured as desired by the user.

To launch the Calibration Wizard:

1. Select “Calibrate”, then Calibration Wizard.
2. Select default values or current values as a starting point in the calibration. When adjusting a DSS-2 that, for the most part, has the desired calibration, it is best to use “current values”.

3. Enter the number of teeth on the flywheel. If you wish to work in Hz, enter a value of 60. If you wish to work in rpm, enter the correct number of flywheel teeth.

4. Information in the following sections will detail how ACT can be used to configure both channels and the Engine Protection (EP) input.

---

**CAUTION**

The DSS-2 is a user-configurable engine control device and will follow your settings and commands immediately. Please be aware of this when calibrating and entering values in the unit.

It is possible to enter values in the DSS-2 unit that are in excess of what the engine is capable of performing and outside of safe operating range.

It is the user’s responsibility to be accurate when entering data into the DSS-2 or the ACT. Entering values outside of safe operating range can result in serious physical injury and/or damage to the equipment or application.
Speed Switch Configuration

As shipped from the factory, DSS-2 is configured as follows:

- Two-channel speed switch
- Normal operation
- Automatic reset at 80% of setspeed
- Range of pot adjustable set speed: 2500 to 5000 Hz
- Go to set condition on EP switch input
- Set speed reduced to 70% on VER switch input

The speed setpoints can be calibrated manually by adjusting the two potentiometers on the front of the DSS-2 controller.

A typical speed switch installation is shown below.

In this example, Channel 1 is configured as a crank disable switch that disconnects power to the starter motor when engine speed rises above the set speed. Channel 2 is configured as an overspeed shutdown switch that will interrupt power to the ignition coil when an overspeed threshold is exceeded.

![Figure 4. Typical Speed Switch Installation](image-url)
Manual Calibration

Calibration is best done with a frequency generator to simulate the engine speed input and a frequency meter. A zero-crossing input of 2 Vac minimum is required. Setup consists of the following:

1. Set potentiometers to maximum frequency (fully clockwise – potentiometer will click at end of travel).
2. Apply power to controller. All three LEDs should turn on for one second, indicating normal operation.
3. Turn on frequency generator and set to desired frequency. The green status LED should turn on continuously, indicating a good speed signal from the generator.
4. Adjust speed setpoints until desired set speeds are achieved. Red LEDs should illuminate when set speeds are reached.
5. Install DSS-2 on engine and confirm MPU input with engine running. Confirm speed switch operation. If concerned about overspeeding the engine or load, attach 12 volts to the verify (VER) input. Speed switching will occur at 70% of the actual set speed.

The range of set speeds commanded is adjustable using the ACT. Due to the resolution of the internal digital electronics, it may not be possible to adjust operation to the exact frequency (e.g. 60.1 Hz vs 60 Hz). The wider the range, the coarser the resolution.

Speed Switch Calibration Using ACT

The All-purpose Calibration Tool (ACT) can be used to provide a wide variety of custom features to the DSS-2. Refer to Chapter 5 for general information regarding installation, connection and operation of ACT. The Calibration Wizard is the preferred approach to ACT calibration, but similar results can be obtained using the Calibrate/Change DSS-2 Calibration Menu item.

To launch the Calibration Wizard:

1. Select “Calibrate”, then Calibration Wizard.
2. Select default values or current values as a starting point in the calibration.
3. Enter the number of teeth on the flywheel. If you wish to work in Hz, enter a value of 60. If you wish to work in rpm, enter the correct number of flywheel teeth.
4. The following information applies to both Channel 1 and Channel 2.
Normal Operation vs. Reverse Operation

In the first Wizard window, left click on the down arrow in the selection box and select normal or reverse operation. Click on Next to move on to the next selection.

Reset Mode: Auto/Manual/Latch

Click on the down arrow in the selection box and select the desired reset mode.

**Auto Reset:** The speed switch will automatically return to the “Reset” state when speed falls below a percentage of the setspeed. The percentage is selected in the next window.

**Manual Reset:** The speed switch will return to the “Reset” state when the speed falls below the setspeed AND the RST switch input is connected to battery voltage.

**Latched Reset:** The speed switch will remain in the “Set” state until the DSS-2 module is powered down then powered back up.
Speed Switch Options

Potentiometer Control Range:
Set Speed Min and Set Speed Max specify the range of engine speeds (frequencies) controllable with the set speed potentiometer. Values of 10-8000 are acceptable. The narrower the range, the finer the resolution on adjustment.

Delay on Set Condition:
Set Delay specifies how long, in msec, that actual speed must exceed the set speed before going to the set condition. This permits the system to ignore small glitches in measured engine speed.

Go to Set Condition on Engine Protection Switch: If the Engine Protection box is checked, the speed switch will go to the set condition any time the Engine Protection Switch input is set to a high voltage, regardless of the speed.

Go to Set Condition when Start/Verify Switch is off: To use the VER input as a “Start/Stop” switch, check the Verify Switch box. Any time the VER input is low, the speed switch will go to the set condition, regardless of the speed. As long as the speed is below the set speed, the speed switch will return to the reset condition when the VER input is connected to high voltage. This feature is useful when using the speed switch for overspeed shutdown as well as start/stop. When this feature is enabled on either channel, the normal verify function will be disabled.

Go to Set Condition on Loss of Speed: If the Loss of Speed = Set box is checked, the speed switch will go to the set condition upon loss of the speed signal. This can be used to assure an engine shutdown in the event that the MPU signal is lost.

Sequence with other channel: If the Sequence box is checked, the speed switch will not go to a set condition based on speed until after the other channel has gone to a set condition.

To generate a fault code when a set condition seen: When auto reset is used, there is not an indication to the operator that a speed switch has gone to the set condition and then returned to the reset condition. Checking the Overspeed Fault Enable box will generate a fault code if the speed switch ever goes to the set condition. The green status lamp will flash a fault code indicating the overspeed fault.

Delay on Reset Condition: When the speed switch is configured for automatic reset, Reset Delay specifies how long, in msec, that actual speed must fall below the reset speed before going to the reset condition. This permits the system to ignore small glitches in measured engine speed. Reset Speed = Set Speed * Reset Percentage. This option is not displayed if manual reset or latched reset is selected.

To Adjust Reset Speed: When the speed switch is configured for automatic reset, the user can select the speed below which the speed switch will return from the set
condition to the reset condition. The reset speed is expressed as a percentage of
the set speed so that adjustments to the set speed with the set speed potentiometer
will also affect the reset speed. Reset Speed = Set Speed * Reset Percentage

Autocrank Configuration

As shipped from the factory, both DSS-2 channels are configured as speed
switches. The ACT is required to enable Autocrank operation. Once enabled, the
Crank Disconnect rpm can be manually adjusted using the potentiometer. Other
features which can be adjusted using the ACT include:

- Maximum engine cranking time
- Engine rest time between crank attempts
- Maximum number of crank attempts before giving up.
- Range of pot adjustable crank disconnect speed: default value
  2500 to 5000 Hz
- Disable autocrank on EP switch input

If either channel is configured for autocrank, the normal Verify function is disabled.
The autocrank sequence is as follows:

1. The autocrank sequence is initiated by applying battery power to the VER
   switch input. If power is removed from the VER switch input at any time, the
   autocrank process will be terminated.
2. If one of the channels is configured as a glow plug controller, it will turn on
   for the pre-heat time. The autocrank channel will remain off through the
duration of the glow plug pre-heat cycle.
3. The autocrank channel and the red LED will turn on to initiate cranking. If an
   engine speed signal is not seen within AUTOCRANK_NS_TIME, a fault will
   be generated and the autocrank sequence terminated.
4. The autocrank channel will remain on for AUTOCRANK_CRANK_TIME
   seconds or until engine speed rises above the crank disconnect speed,
   whichever comes first.
5. If engine speed rises above the crank disconnect speed, the autocrank
   process is complete.
6. If the autocrank channel remains on for AUTOCRANK_CRANK_TIME
   seconds, the channel will turn off and enter the rest phase for
   AUTOCRANK_REST_TIME seconds, during which time the red channel
   LED will flash rapidly.
7. After AUTOCRANK_REST_TIME seconds, the crank process will be
   repeated until either the engine starts or AUTOCRANK_MAX_TRIES cycles
   have been performed.
8. If the cycle has been repeated AUTOCRANK_MAX_TRIES times, the
   autocrank process will be terminated and a fault generated.
A typical autocrank installation is shown below.

In this installation, Channel 1 is configured as an overspeed shutdown switch that will interrupt power to the ignition coil when an overspeed threshold is exceeded. Channel 2 is configured as an autocrank controller that will energize the starter motor when the Start Switch is turned on. Additionally, an oil pressure switch and water temperature switch are connected in parallel to the engine protection (EP) input.

**Figure 5. Typical Autocrank Installation**

**Manual Calibration**

Calibration is best done with a frequency generator to simulate the engine speed input and a frequency meter. A zero-crossing input of 2 Vac minimum is required. Setup consists of the following:

1. Set autocrank potentiometer to maximum frequency (fully clockwise – potentiometer will click at end of travel).
2. Apply power to controller. All three LEDs should turn on for one second, indicating normal operation.
3. Turn on frequency generator and set to desired crank disconnect frequency. The green status LED should turn on continuously, indicating a good speed signal from the generator.
4. Apply power to the VER switch input to initiate the starting sequence. If one channel is configured as a Glow Plug controller, it will turn on first for the pre-heat duration.

5. When the red LED for the autocrank channel turns on, begin turning the potentiometer counterclockwise until the LED turns off. If the crank timer times out before reaching the crank disconnect speed, the LED will begin flashing rapidly indicating the rest period between crank attempts. Resume adjustment when the next crank cycle begins, or cycle power to the VER switch to re-initiate the crank sequence.


The range of setspeeds commanded is adjustable using the ACT. Due to the resolution of the internal digital electronics, it may not be possible to adjust operation to the exact frequency (e.g. 60.1Hz vs 60 Hz). The wider the range, the coarser the resolution.

Autocrank Calibration Using ACT

ACT can be used to customize the Autocrank feature in DSS-2. Refer to Chapter 5 for general information regarding installation, connection and operation of ACT. The Calibration Wizard is the preferred approach to ACT calibration, but similar results can be obtained using the Calibrate/Change DSS-2 Calibration Menu item.

To launch the Calibration Wizard:

1. Select “Calibrate”, then Calibration Wizard.
2. Select default values or current values as a starting point in the calibration.
3. Enter the number of teeth on the flywheel. If you wish to work in Hz, enter a value of 60. If you wish to work in rpm, enter the correct number of flywheel teeth.
4. The following information applies to both Channel 1 and Channel 2.

Enabling Autocrank

In the first Wizard window, left click on the down arrow in the selection box and select Autocrank Controller. Click on Next to move on to the next selection.
Autocrank Options

**Engine Crank Time (sec):**
This option permits adjustment of the maximum crank duration. If crank time exceeds this time, the engine will enter a rest period.

**Rest Time (sec):**
This option specifies the rest, or cooling period, between crank attempts.

**Maximum number of crank attempts:** Specifies the maximum number of attempts to start the engine after which the autocrank sequence will be terminated.

**Maximum Crank Disable Speed (rpm):** Specifies the maximum crank disable rpm selectable with the channel potentiometer.

**Minimum Crank Disable Speed (rpm):** Specifies the minimum crank disable rpm selectable with the channel potentiometer.

**To disable autocrank when an engine protection fault exists:** Checking the box labeled “Disable crank on Engine Protect” will terminate the autocrank process if a high voltage exists on the EP switch input.

**Glow Plug Controller Configuration**

As shipped from the factory, both DSS-2 channels are configured as speed switches. The ACT is required to enable glow plug controller operation. The other channel must be configured for Autocrank operation. Once enabled, the Glow Plug Preheat time can be manually adjusted using the potentiometer. The ACT can be used to adjust maximum engine pre-heat time.

The glow plug sequence is as follows:

1. The autocrank/glow plug sequence is initiated by applying battery power to the VER switch input. If power is removed from the VER switch input at any time, the sequence will be terminated.
2. The channel configured as a glow plug controller will turn on for the pre-heat time. The LED for the glow plug channel will be illuminated. The autocrank channel will remain off through the duration of the glow plug pre-heat cycle.
3. Following the glow plug preheat, the autocrank channel and the red LED will turn on to initiate cranking. The glow plugs will remain on during cranking and will turn off once the engine starts.
4. During the autocrank rest period, the glow plugs will remain on if the pre-heat time is greater than AUTOCRANK_REST_TIME. If the pre-heat time is less, the glow plugs will be turned off until pre-heat time before the next crank attempt.
5. If engine speed rises above the crank disconnect speed, the autocrank process is complete and the glow plugs will be turned off.
A typical glow plug installation is shown below.

In this installation, Channel 1 is configured as an autocrank controller that will energize the starter motor when the Start Switch is turned on and after the glow plug pre-heat sequence is complete. Channel 2 is configured as a glow plug controller that will energize the glow plug relay as soon as the start switch is turned on. Additionally, an oil pressure switch is connected to the engine protection (EP) input.

Figure 6. Typical Glow Plug Installation

Manual Calibration

Calibration is best done with a frequency generator to simulate the engine speed input and a frequency meter. A zero-crossing input of 2 Vac minimum is required. Setup consists of the following:

1. Set glow plug potentiometer to maximum time (fully clockwise – potentiometer will click at end of travel).
2. Apply power to controller. All three LEDs should turn on for one second, indicating normal operation.
3. Turn on frequency generator and set to the crank disconnect frequency. The green status LED should turn on continuously, indicating a good speed signal from the generator.

4. Apply power to the VER switch input to initiate the starting sequence. The Glow Plug controller will turn on first for the pre-heat duration.

5. When the red LED for the autocrank channel turns on, the pre-heat time is over. Use the glow plug channel potentiometer to adjust the pre-heat time.

6. Install DSS-2 on engine and confirm glow plug and autocrank operation. Adjust pre-heat time as required.

The range of pre-heat times commanded is adjustable using the ACT. The range can be varied with the potentiometer between zero and GLOW PLUG_TIME.

**Glow Plug Controller Adjustment Using ACT**

ACT can be used to customize the range of glow plug pre-heat times in the DSS-2. Refer to Chapter 5 for general information regarding installation, connection and operation of ACT. The Calibration Wizard is the preferred approach to ACT calibration, but similar results can be obtained using the Calibrate/Change DSS-2 Calibration Menu item.

To launch the Calibration Wizard:

1. Select “Calibrate”, then Calibration Wizard.
2. Select default values or current values as a starting point in the calibration.
3. Enter the number of teeth on the flywheel. If you wish to work in Hz, enter a value of 60. If you wish to work in rpm, enter the correct number of flywheel teeth.
4. The following information applies to both Channel 1 and Channel 2.

**Enabling Glow Plug Control**

In the first Wizard window, left click on the down arrow in the selection box and select Glow Plug Controller. Click on Next to move on to the next selection.
Pre-Heat Time

Range of Adjustable Pre-heat Time:
This parameter adjusts the maximum value for Glow Plug pre-heat time. The multi-turn potentiometer for the channel assigned to glow plug control can be used to adjust the pre-heat time between zero and this parameter.

Engine Protection Switch Configuration

ACT can be used to configure the Engine Protection (EP) input to the DSS-2. Refer to Chapter 5 for general information regarding installation, connection and operation of ACT. The Calibration Wizard is the preferred approach to ACT calibration, but similar results can be obtained using the Calibrate/Change DSS-2 Calibration Menu item.

To launch the Calibration Wizard:

1. Select “Calibrate”, then Calibration Wizard.
2. Select default values or current values as a starting point in the calibration.
3. Enter the number of teeth on the flywheel. If you wish to work in Hz, enter a value of 60. If you wish to work in rpm, enter the correct number of flywheel teeth.
4. Follow the steps covered in previous sections to configure the two speed switch channels.

To ignore EP input before starting: Some engine protection inputs, such as oil pressure switches, indicate a failure when the engine is not running. To prevent latching of unintended faults, set Enable RPM to a non-zero value that indicates normal engine operation.
To Ignore EP input for a brief period after starting: Set Run Time (sec) to a non-zero value.

To ignore intermittent switch contact closures: To provide some basic switch contact debounce, set Debounce Time (msec) to a non-zero value.

To detect an absent speed input: If a channel is configured as a speed switch which latches a fault on loss of speed signal, it is possible to detect a missing speed signal without having first seen a valid speed signal. Set Loss of Speed Signal time (sec) to a non-zero value. Once battery power is applied to the VER switch input (Start Switch), the Loss of Speed Signal logic expects to see a speed signal with this amount of time.

Completing Wizard Configuration

After configuring the Engine Protection input, the Wizard presents a summary page. The user should confirm all settings and use the “<Back” button to correct any discrepancies.

After reviewing the summary, click on “Next>” to download the values to the DSS-2.

The final screen presents a signoff message. Select “Finish” to complete the calibration process.
Chapter 5.
ACT Operation

ACT Installation

ACT Kit Contents

The All-purpose Calibration Tool (ACT) is used for programming (configuring and adjusting) and monitoring the DSS-2 controller with your personal computer. The ACT kit contains the following:

- Software CD-ROM
- RS-232 connecting cable
- CD-ROM Installation Guide

Set-up Requirements

Hardware Requirements

- IBM compatible personal computer equipped with a CD-ROM drive and a serial port with DB-9 connector, capable of 9600 baud communication
- Windows software: 95/98/Me/2000/XP
- 64 MB of available RAM memory and a hard disk with at least 2.0 megabyte of free disk space
- SVGA capable video card and monitor, capable of 256 colors and 800 x 600 display

Software Requirements

CD-ROM of calibration tool software to run on your personal computer.
(CD supplied with ACT kit.)

Hardware Set-up

To connect your PC to the DSS-2 use the cable provided with the calibration tool kit. This cable has a DB-9 connector on one end and a four-pin white plastic Molex connector on the other end. Please note that the DSS-2 serial communication port is for service and programming only; it is not intended for a cable connection during operation.

Connect one end of the RS-232 cable to your PC’s COM port. Connect the other end of the cable to the control module.

NOTE
The DSS-2 must be powered up in order for ACT to operate.

CAUTION
The serial/COM port and ACT software are intended only for configuration and periodic service. Do not leave a computer and/or serial/COM cable connected to the serial/COM port.
Software Set-Up

ACT software can be automatically installed on your hard drive from the CD-ROM supplied with the kit. To install the software, follow the procedures below.

NOTE
Close all applications to prevent possible conflict between the ACT installer and other programs.

1. Turn on your computer and insert the ACT disk into the CD-ROM drive. The install program should automatically launch. If it does not, open Windows Explorer, go to the CD-ROM drive and double click on the install program.

2. Follow the prompts from the install program. You may select the default directory or specify your own.

3. When installation is complete, you may access the ACT software from the Start Menu or create your own shortcut.

4. The set-up is now complete and you are ready to run ACT.
   - To run the ACT software, please refer to “Running the ACT Software” in the following section.
   - Put the original CD-ROM in a safe place in case the files on your hard drive become damaged or lost.
Basic ACT Operation

Running the ACT Software

The ACT software is fairly easy to use. Follow the procedures below to run the program.

1. Make certain that the DSS-2 controller is powered up and connected to the computer’s COM port.

2. If an icon for the calibration tool exists, double click on it to start the ACT software. The license screen will be displayed when the ACT is launched. You must either accept the terms or Cancel, which exits the application.

3. If no icon exists, click on the Start button, highlight “Programs,” find the ACT software and click to start it. Default is Woodward, then select “APECs-EPS Calibration Tool.”

4. Make sure the COM port designation in ACT matches the serial port on the back of your PC.

5. Follow the procedure outlined in the Configure Menu to change the COM port assignment, if needed.

Progress Display Screen

This screen is intended to inform the user of the progress of time-consuming communication procedures. It will close automatically when the procedure is complete.
Moving Around the Software

There are five main menu items available with ACT. Several options are available under each main menu item. The discussion in the following pages assumes the cursor is at the main menu screen.

- Use mouse to select or move around the menu.
- Use left mouse to execute a command or accept a condition.
- Use function key <F1> for HELP.
- A HOT key (highlighted character in a menu item) can also be used to access or activate a menu or sub-menu, e.g. File use <ALT> <F>.
- Click on the x box in the upper right hand corner to exit ACT.

ACT Menus & Options

ACT Menu Structure

ACT's five main menus—File Menu, Calibrate Menu, Monitor Menu, Configure Menu, and Help Menu have several options available under each. A complete discussion of all ACT menus and options is presented in the following pages.

<table>
<thead>
<tr>
<th>ACT Menu Structure</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>FILE MENU</strong></td>
<td>Save DSS-2 Cal to File</td>
</tr>
<tr>
<td></td>
<td>View Cal File Comments</td>
</tr>
<tr>
<td></td>
<td>View Text File</td>
</tr>
<tr>
<td></td>
<td>Convert DSS-2 Cal to Text</td>
</tr>
<tr>
<td></td>
<td>Convert Cal File to Text</td>
</tr>
<tr>
<td></td>
<td>Convert Cal File to Strategy</td>
</tr>
<tr>
<td><strong>CALIBRATE MENU</strong></td>
<td>Change DSS-2 Calibration</td>
</tr>
<tr>
<td></td>
<td>Download Cal File to DSS-2</td>
</tr>
<tr>
<td></td>
<td>Compare DSS-2 Cal to File Cal</td>
</tr>
<tr>
<td></td>
<td>Change DSS-2 Password</td>
</tr>
<tr>
<td></td>
<td>DSS-2 Calibration Wizard</td>
</tr>
<tr>
<td><strong>MONITOR MENU</strong></td>
<td>Parameter View</td>
</tr>
<tr>
<td></td>
<td>Parameter Plot</td>
</tr>
<tr>
<td></td>
<td>Display Faults</td>
</tr>
<tr>
<td></td>
<td>Control Strategy</td>
</tr>
<tr>
<td></td>
<td>Parameter List</td>
</tr>
<tr>
<td><strong>CONFIGURE MENU</strong></td>
<td>Configure Serial Port</td>
</tr>
<tr>
<td><strong>HELP MENU</strong></td>
<td>Help Topics</td>
</tr>
<tr>
<td></td>
<td>About ACT</td>
</tr>
<tr>
<td></td>
<td>User Manuals</td>
</tr>
</tbody>
</table>
File Menu

Purpose

The File Menu allows you to perform operations related to viewing, saving and converting files. The following commands are available under the File Menu.

- Save DSS-2 Cal to File
- View Cal File Comments
- View Text File
- Convert DSS-2 Cal to Text
- Convert Cal File to Text
- Convert Cal File to Strategy

Save DSS-2 Cal to File

This command allows you to save DSS-2 calibration data to a designated file. The ACT uploads the calibration set from the DSS-2 controller and saves it to a computer file. This operation is usually done after the controller has been calibrated for satisfactory engine performance but can also be done at any other time. The data is saved in a binary file format that is not readable.

To Save DSS-2 Cal to File:

   
   ACT will prompt the path where the file will be saved:

2. Enter a file name to save the calibration data to.
   
   ACT will automatically append the file extension .ACT to the file name if you do not specify one. Click Save or press <Enter>.

   ACT will then read all of the current calibration values from the controller. This screen shows the progress.

   Once all the values are read, ACT will prompt you to add comments to the ACT file to aid in later identification.
3. If you click **Yes**, the comment editor screen will appear.

To enter comments, type them one at a time and press <Enter> or click Save Edit. You can re-edit comments by clicking them, changing the text on the top line and clicking Save Edit. Comments can be deleted by clicking on them and then clicking “Delete” or by pressing <Del>.

4. Click OK on the comment editor or press <Enter> twice to save comments. Click Cancel or press <Esc> twice to close the window without saving comments. The Cal File will still be created if the comment editor is canceled.

5. The following message is displayed when the file is created successfully.

The file name in this message is the file selected in Step 2. ACT will save the calibration data to the designated file and display “Calibration Data Saved in File: ABCD.ACT” message (where ABCD is the name you entered in Step 2).

**NOTE**

The “Save DSS-2 Cal to File” command stores the calibration data as an .ACT file that cannot be viewed or printed directly. Viewing and printing must be done from a converted text file. See “Convert DSS-2 Cal to Text” and “Convert Cal File to Text” commands.

**View Cal File Comments**

This command allows you to display the comments that are attached to a calibration file. Users add comments when saving a calibration file. The comments help in tracking specific engine, application, and environment data for which the calibration file was created.

**To View Calibration Comments:**


ACT will display a list of files on the left side of the screen with file comments on the right:
2. Use the Up and Down arrow keys to highlight the desired calibration file (.ACT extension) and view the comments attached to that file.

3. Click OK or Cancel to close Comment Viewer. The comments are created or edited when the files are created.

**View Text File**

This command is a convenient way to view text files.

2. ACT will prompt for a text file to view.
3. Select a file and click OK.
4. ACT will open the selected file with the default viewer for that file type.

**Convert Commands**

The “Save DSS-2 Cal to File” command, discussed earlier, stores the calibration data as an .ACT file that cannot be viewed or printed directly. Viewing and printing must be done from a converted text file.

There are two convert commands available with ACT: “Convert DSS-2 Cal to Text” and “Convert Cal File to Text.” The difference between the two commands is as follows:

1. In “Convert DSS-2 Cal to Text” operation, the calibration set that is converted is from the DSS-2 unit.
2. In “Convert Cal File to Text” operation, the calibration set that is converted is from a previously saved file.

You may use the View Text File command to view text files.

**Convert DSS-2 Cal to Text**

This command allows you to create a text file of DSS-2 calibration data for viewing or printing from any text editor utility in Windows. A printed copy of the calibration data can be useful for future reference.

**To Convert DSS-2 Calibration to Text:**

1. Choose File → Convert DSS-2 Cal to Text.

2. ACT will prompt you to enter a name to save the text file. Enter a file and click OK.
   
   ACT will read all of the calibration values from the controller, create and save a text file with the parameter names, values, and units, then display the file using the default text viewer.
Convert Cal File to Text

This command allows you to convert a previously saved .ACT calibration file to a text file for viewing or printing from any text editor utility in Windows. A printed copy of the calibration data can be useful for future reference.

To Convert Cal File to Text:

1. Choose File → Convert Cal File to Text.
2. ACT will prompt you to enter a name to save the text file. Enter a file and click OK.
   ACT will read all of the calibration values from the controller, create and save a text file with the parameter names, values, and units, then display the file using the default text viewer.

Convert Cal File to Strategy

This command is used to convert old ACT files for use with controllers that have a different control strategy version.

ACT will:
1. Parse through all of the calibration parameters in the old ACT file.
2. Search for the same calibration parameters in the new ACT file and assign values from the old calibration.

To Convert a Cal File to a New Strategy:

2. ACT will prompt you to enter a name to save the text file. Enter a file and click OK.
   ACT will read all of the calibration values from the controller create and save a text file with the parameter names, values, and units, then display the file using the default text viewer.

Calibrate Menu

The Calibrate Menu allows you to perform operations related to DSS-2 calibration.
The following commands are available:

- Change DSS-2 Calibration*
- Download Cal File to DSS-2*
- Compare DSS-2 Cal to File Cal
- Change DSS-2 Password*
- DSS-2 Calibration Wizard*

(*) These commands can be password protected to prevent unauthorized calibration changes. See “Change DSS-2 Password” for more information.

Change DSS-2 Calibration

The “Change DSS-2 Calibration” command allows you to calibrate (configure and adjust) various parameters associated with the DSS-2 controller.
DSS-2 is a programmable speed switch. Changing DSS-2 calibration parameters is a means to configure the DSS-2 controller for specific engines, applications and environments.

The calibration parameters have been organized into categories for your convenience. Browse through the categories to view the specific parameter you want to change or adjust.

Some parameters must be set before the engine can run. Other parameters can be adjusted while the engine is running. A complete list of parameters appears in the following pages.

All adjustments are stored immediately in non-volatile memory in the DSS-2 unit. The DSS-2 controller will retain the changes even if power is lost or the ACT is disconnected.

To Change DSS-2 Calibration Parameters:

2. Set the “View Filter” to select a group of parameters.
3. Use the mouse to scroll through the list.
4. To change the highlighted parameter:
   - Enter the new value in the “New Value” field.
   - Press <Enter>.
   - The new value is written to the controller and then read back, with the result placed in the “DSS-2 Value” field.
5. Press <Esc> to exit.
Calibration Categories

To incorporate any of the programmable features in your system, a set of parameters associated with each feature must be calibrated using the calibration tool (ACT). These parameters are grouped under various categories under the Calibrate Menu in ACT. (Refer to Table 1 below.)

Table 1. Calibration Categories and Features

<table>
<thead>
<tr>
<th>CALIBRATION CATEGORY</th>
<th>FEATURES AVAILABLE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel 1 Calibration</td>
<td>Operating Mode (Normal / Reverse / Autocrank / Glow Plug)</td>
</tr>
<tr>
<td></td>
<td>Reset Mode (Auto / Switch / Latch)</td>
</tr>
<tr>
<td></td>
<td>Speed Range</td>
</tr>
<tr>
<td></td>
<td>Set/Reset Delays</td>
</tr>
<tr>
<td>Channel 2 Calibration</td>
<td>Operating Mode (Normal / Reverse / Autocrank / Glow Plug)</td>
</tr>
<tr>
<td></td>
<td>Reset Mode (Auto / Switch / Latch)</td>
</tr>
<tr>
<td></td>
<td>Speed Range</td>
</tr>
<tr>
<td></td>
<td>Set / Reset Delays</td>
</tr>
<tr>
<td>Speed Input Calibration</td>
<td>Number of pulses on flywheel</td>
</tr>
<tr>
<td>Engine Protection Switch</td>
<td>Enable rpm / delay</td>
</tr>
<tr>
<td>Autocrank/Glow Plug Calibration</td>
<td>Crank Time</td>
</tr>
<tr>
<td></td>
<td>Rest Time</td>
</tr>
<tr>
<td></td>
<td>Maximum Crank Attempts</td>
</tr>
<tr>
<td>All Parameters</td>
<td>Contains list of all calibration parameters</td>
</tr>
</tbody>
</table>
List of Parameters

The parameter list provides information regarding each of the parameters that can be adjusted when a computer is connected to the controller via the COM port and the ACT software. The COM port and ACT are intended only for configuration and periodic service. **Do not leave a computer and/or COM cable connected to the COM port.**

<table>
<thead>
<tr>
<th>CATEGORY</th>
<th>PARAMETER</th>
<th>DESCRIPTION</th>
<th>FACTORY CAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel 1 Calibration</td>
<td>CHNL_1_CONFIG</td>
<td>Configuration bits, Channel 1. Bit 7: 1 = Overspeed Fault Enable Bit 5: 1 = Sequence bit – Ch 1 after Ch1 Bit 4: 1 = Go to set on Loss of Speed Signal Bit 3: 1 = Go to set on Verify Sw = Off Bit 0: 1 = Go to set on EP switch active</td>
<td>000000001B</td>
</tr>
<tr>
<td></td>
<td>CHNL_1_OP_MODE</td>
<td>0 = speed switch, standard relay logic 1 = speed switch, reverse relay logic 2 = autocrank, using Verify Sw 3 = glow plug mode, using Verify Sw.</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>CHNL_1_RESET</td>
<td>0,1 = auto reset at RESET_PCNT_1 of Channel 1 set speed 2 = reset with external RST switch 3 = latched reset</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>RESET_DELAY_1</td>
<td>When in auto reset, time below reset speed before reset occurs</td>
<td>0 msec</td>
</tr>
<tr>
<td></td>
<td>RESET_PCNT_1</td>
<td>When in auto reset, percentage of set speed at which reset will occur</td>
<td>80%</td>
</tr>
<tr>
<td></td>
<td>SET_DELAY_1</td>
<td>Time above set speed before set will occur</td>
<td>0 msec</td>
</tr>
<tr>
<td></td>
<td>SET_SPEED_1_MIN</td>
<td>Minimum set speed/frequency from Channel 1 potentiometer</td>
<td>2500 Hz</td>
</tr>
<tr>
<td></td>
<td>SET_SPEED_1_MAX</td>
<td>Maximum set speed/frequency from Channel 1 potentiometer</td>
<td>5000 Hz</td>
</tr>
<tr>
<td>CATEGORY</td>
<td>PARAMETER</td>
<td>DESCRIPTION</td>
<td>FACTORY CAL</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>CHNL_2_CONFIG</td>
<td>Configuration bits, Channel 2. Bit 7: 1 = Overspeed Fault Enable Bit 5: 1 = Sequence bit – Ch 1 after Ch 1 Bit 4: 1 = Go to set on Loss of Speed Signal Bit 3: 1 = Go to set on Verify Sw = Off Bit 0: 1 = Go to set on EP switch active</td>
<td>00000001B</td>
</tr>
<tr>
<td>Channel 2 Calibration</td>
<td>CHNL_2_OP_MODE</td>
<td>0 = speed switch, standard relay logic 1 = speed switch, reverse relay logic 2 = autocrank, using Verify Sw 3 = glow plug mode, using Verify Sw</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>CHNL_2_RESET</td>
<td>0,1 = auto reset at RESET_PCNT_1 of Channel 1 set speed 2 = reset with external RST switch 3 = latched reset</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>RESET_DELAY_2</td>
<td>When in auto reset, time below reset speed before reset occurs</td>
<td>0 msec</td>
</tr>
<tr>
<td></td>
<td>RESET_PCNT_2</td>
<td>When in auto reset, percentage of set speed at which reset will</td>
<td>80%</td>
</tr>
<tr>
<td></td>
<td>SET_DELAY_2</td>
<td>Time above set speed before set will occur</td>
<td>0 msec</td>
</tr>
<tr>
<td></td>
<td>SET_SPEED_2_MIN</td>
<td>Minimum set speed/frequency from Channel 2 potentiometer</td>
<td>2500 Hz</td>
</tr>
<tr>
<td></td>
<td>SET_SPEED_2_MAX</td>
<td>Maximum set speed/frequency from Channel 2 potentiometer</td>
<td>5000 Hz</td>
</tr>
<tr>
<td>Speed Input Configuration</td>
<td>PULSES_PER_REV</td>
<td>No. of pulses per engine revolution (if set to 60, rpm = Hz)</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>PULSES_PER_UPDATE</td>
<td>No. of pulses until next engine speed update</td>
<td>0</td>
</tr>
</tbody>
</table>
## Parameter List (Cont'd.)

<table>
<thead>
<tr>
<th>CATEGORY</th>
<th>PARAMETER</th>
<th>DESCRIPTION</th>
<th>FACTORY CAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Engine Protection Switches</td>
<td>EP_ENABLE_RPM</td>
<td>Minimum rpm to enable engine protection switch</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>EP_RUN_TIME</td>
<td>Minimum time above EP_ENABLE_RPM to enable engine protection switch</td>
<td>0 sec</td>
</tr>
<tr>
<td></td>
<td>EP_TIME</td>
<td>Minimum engine protection switch closure time</td>
<td>50 msec</td>
</tr>
<tr>
<td></td>
<td>LOSS_TIME</td>
<td>Minimum time without speed signal on startup to go to set condition if Loss of Speed Signal set mode is enabled (CHNL_CONFIG.4 = 1)</td>
<td>5 sec</td>
</tr>
<tr>
<td></td>
<td>TEST_VERIFY_K</td>
<td>Percentage of normal set speed to go to set condition when Verify Switch is activated</td>
<td>0.7</td>
</tr>
<tr>
<td>Autocrank / Glow Plug Calibration</td>
<td>AUTOCRANK_CONFIG</td>
<td>1 = Disable autocrank if engine protection fault exists</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>AUTOCRANK_CRANK_TIME</td>
<td>Maximum engine cranking time before resting</td>
<td>10 sec</td>
</tr>
<tr>
<td></td>
<td>AUTOCRANK_MAX_TRIES</td>
<td>Maximum number of crank attempts</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>AUTOCRANK_NS_TIME</td>
<td>Time between onset of cranking and a fault if no engine speed is observed</td>
<td>1 sec</td>
</tr>
<tr>
<td></td>
<td>AUTOCRANK_REST_TIME</td>
<td>Rest time between crank attempts</td>
<td>15 sec</td>
</tr>
<tr>
<td></td>
<td>CRANK_DISABLE</td>
<td>Engine rpm above which autocrank will be terminated and normal engine rpm assumed</td>
<td>700 rpm</td>
</tr>
<tr>
<td></td>
<td>GLOW PLUG_TIME</td>
<td>Maximum glow plug preheat time before enabling crank. The actual glow plug preheat time can be adjusted downward with the potentiometer.</td>
<td>10 sec</td>
</tr>
</tbody>
</table>
Download Cal File to DSS-2

The “Download Cal File to DSS-2” command allows you to download the entire calibration set from a file to the DSS-2 permanent memory. This is a convenient one-step method for:

- Reverting back to a known good calibration set after experimenting with new calibration settings
- Programming multiple DSS-2 units for a particular application

The downloaded file may have been previously configured and calibrated for satisfactory engine performance with another DSS-2 unit.

To Download a Cal File to DSS-2:

1. Choose Calibrate → Download Cal File to DSS-2. The following screen allows you to select a Cal file to download.

2. Choose a file and click OK. The following screen will show the progress.

3. The following screen is shown when the operation is complete.

NOTE: During the “Download Cal File to DSS-2” operation, the user may encounter a situation where the Cal File password is different from that of the DSS-2 unit. If this happens, please refer to the steps below to complete the download operation.
To Download a Cal File to DSS-2 with a Password Different from that of the DSS-2 Unit:

Whenever the DSS-2 password is added or changed, the new password is stored in the unit as well as in any calibration file saved after the change.

During a “Download Cal File to DSS-2” operation, if the password stored in the calibration file matches the password in the unit, ACT will readily download the calibration to the DSS-2 unit.

However, if the password stored in the calibration file does not match the password in the DSS-2 unit, ACT will alert you of a password mismatch. Please follow the steps below to complete the download operation.

1. When a password mismatch is detected, the ACT displays a message “Cal File password differs from that of the DSS-2 unit. Download the Cal File password to the DSS-2 unit?”

2. If you answer Yes to this message (see note below), the calibration file will be downloaded and the password in the DSS-2 unit will be changed to match the password stored in the calibration file.

3. If you answer No to this message, the calibration file will still be downloaded but the password in the unit will remain unchanged.

**NOTE**

Before answering Yes to the message, make sure you know the password in the calibration file. If you do not know the password, you will not be able to access the password protected features under the Calibrate menu.

Please see “Change DSS-2 Password” command for more information on password protection.

**Compare DSS-2 Cal to File Cal**

This command lets you check the differences in calibration sets between a saved file and the DSS-2 unit. The feature is useful, for example, to ensure that the saved file matches the calibration in the DSS-2 unit.

**To Compare DSS-2 Cal to File Cal:**

1. Choose File → Compare DSS-2 Cal to File Cal. This screen allows you to select a Cal File to compare.
2. Choose a file and Click OK. This screen will show the progress.

3. Once all parameters have been processed, a message box will list the compare results. If the parameters in the file match the controller, the following message box appears:

4. Click OK to close. If there were mismatches, the following message will appear:

You may select "Save to File" if you would like to save a permanent record of the file compare. You will then be asked to select a destination directory and file name.

**Change DSS-2 Password**

This command allows you to add or change a password to protect certain calibration features. The option is useful, for example, to prevent unauthorized changes to a known good calibration set in the DSS-2 unit.

By default, the DSS-2 unit is not password protected.

**To Change DSS-2 Password:**

1. Choose Calibrate → Change DSS-2 Password. You will be prompted for the current password.
2. The application will query the controller to verify that the entered password matches the current password. If the password matches, the “Change” button is enabled:

3. Click “Change” and the application will prompt for the new password:

4. Enter the new password. It should be one word, no spaces, and up to 11 characters long. Once entered, click OK. The application will prompt to re-enter the password to make sure that it was typed in properly:

5. Re-enter the password and click OK. If the two entries of the new password are equal, the new password will be encoded and saved in the controller.

*Passwords are upper and lower case sensitive.*

After changing your password, please record it in a safe place for future reference. To revert to no password protection, change DSS-2 password to “peg,” which is the default password.

**ACT Operation with the New Password:**

Once a password is added or changed, the following calibration features become password protected:

- Change DSS-2 Calibration
- Download Cal File to DSS-2
- Change DSS-2 Password
- DSS-2 Calibration Wizard

At the start of any future sessions, ACT will always prompt you to enter the new password to gain access to these features. You only need to enter the password once during any session to gain access to all password protected features.
DSS-2 Calibration Wizard

The DSS-2 Calibration Wizard is an interactive guide to help you get your controller unit up and running as quickly as possible.

To Calibrate a Controller Unit Using the DSS-2 Calibration Wizard:

1. Choose Calibrate → Calibration Wizard (or select the tool button shown above).

2. The Wizard will give you the option to use the default calibration or modify the existing one. If you select the default calibration, the Wizard will reset all calibration parameters.

3. Press <Enter> to continue or <Esc> to abort the Wizard.

   If you press <Enter> the Wizard will lead you through the calibration process with a series of questions. When all questions have been answered the Wizard will ask you to confirm that the values entered are accurate.

4. Press <Enter> to confirm the values, <PgUp> to go back and change the values, or <Esc> to abort the Wizard.

   If you press <Enter>, the DSS-2 Wizard will download the new calibration and reset all DSS-2 parameters. This will complete the DSS-2 Wizard operation.

**NOTE**
The DSS-2 Calibration Wizard only covers basic calibration. It does not automatically assure optimum engine operation. Please refer to DSS-2 Calibration Procedures for more information.
Monitor Menu

The Monitor Menu allows you to observe engine and DSS-2 operation in real time. The following commands are available under the Monitor Menu:

- Parameter View
- Parameter Plot
- Display Faults
- Control Strategy
- Parameter List

Parameter View

This command allows you to view certain operating variables (i.e., engine speed) in real time.

To View Parameter Values in Real Time:

1. Choose Monitor → Parameter View. The application will launch the view screen.

2. The screen automatically starts reading values from the controller and displaying the values.

3. To stop the updating, click on Stop. The button name will then change to ‘Start.’ Clicking it again will start updating again.

NOTE
As shipped from the factory, n_desired will actually be in units of Hz, not rpm as indicated. When PULSES_PER_REV = 60, n_desired will display in Hz. To display actual rpm, change PULSES_PER_REV and PULSES_PER_UPDATE to equal the actual number of gear teeth per engine revolution.

NOTE
If any other screen is opened that requires communication with the controller while the screen is updating, the Parameter View screen will be automatically stopped.
Parameter Plot

The Parameter Plot command lets you view engine performance on screen in the form of a real-time graph. This feature allows you to perturb the system and observe the response to fine tune engine performance.

To View Parameter Plot in Real Time:

Select Monitor \(\rightarrow\) Parameter Plot. The application will launch and start the parameter plot view.

The application will read the previously saved configuration and request the controller to start sending the parameter values. The controller sends the data to the PC at a rate that varies with the number of parameters being monitored. The application uses the Windows timer functionality to update the screen at the specified rate. Note that if the PC is very busy, the timer accuracy will vary; therefore, the screen and generated data files should be considered as reference only.

The X-axis time scale (25 seconds in the example screen) may be shorter than configured due to the resolution of the monitor. This value will be adjusted when the graph is resized. This also applies to the print functionality for this screen. All of the data will be recorded in a revolving buffer for use by the “Save to File” feature (see below).

The axis scales, parameter names, update resolution and time scale on the Parameter Plot may be changed as described in the Plot Setup screen.

To Change Plot Setup:

This allows you to choose engine RPM, desired engine speed, duty cycle or any other parameter for viewing real-time plots on screen. Axis scales can also be adjusted to fit the parameter and/or speed.

1. On the Parameter Plot screen, click on “Configure.” The application will show the following screen with the current values.
Plot 1 / Plot 2
Use the pull-down to select the desired parameter to plot.

Axis Min / Max
Enter the minimum / maximum value for the parameter value.

X Axis Time Scale
Controls how much data is displayed on the X axis. This value may automatically adjust for screen resolution.

X Axis Sample Rate
Controls how often the data from the controller is used to update the screen. Data received between timer ticks is discarded.

2. Clicking OK will save this information in the Windows Registry so that it will be remembered the next time the program is started.

NOTE
The Calibration Wizard will automatically set up the plots if there are no saved defaults.

Display Faults
This command allows you to display present faults in real-time. This means if new faults occur while you are monitoring, the screen will automatically update to display the current faults. The display will also show historical fault codes that have been previously logged but do not currently exist. Historical fault codes are helpful when tracking down intermittent faults.

To Display Faults in Real Time:

1. Choose Monitor → Display Faults from the main menu. The application will launch the Fault view.

   The application will update the display every time the controller sends the fault_flags status. This happens several times a second.

2. Click on the “Pause” button to stop the automatic update of this
screen. The text on the button will change to “Start” and clicking it again will re-start the automatic updating.

**NOTE**

If any other screen requests data from the controller while this screen is updating, this screen will automatically pause.

**Control Strategy**

This command allows you to check the version of the control strategy in use. This information may be needed for strategy identification purposes and for future updates.

The Parameter List screen allows the user to adjust which parameters are displayed on the Parameter View display.

**To Display the Parameter List:**

1. Choose Monitor > Parameter List from the main menu.

2. The F5/F6 keys will backup/advance through the list. Press F9 or click on “On View List” to toggle the selected parameter on the Parameter View screen.

3. Click on the x box in the title bar or press <Esc> to close the screen. Edits are not saved between application launches.

4. If the Parameter View screen is already open when changes are made to the view list, close the Parameter View screen and re-open it to make the changes effective.

**Save**

Clicking Save will prompt the user for a file name to save the currently viewed configuration to. Type in a file name that reflects the purpose of the saved configuration and click Save. The view configuration dialog will now display the selected file name in the title bar.

**Open**

Clicking Open will prompt the user for a file name of a previously saved View Configuration. Select the desired file and click Open. The View Configuration will be updated with the saved parameters.
The ACT application will always recall the default set of plot configuration parameters at application startup, and does not recall the last used view setup file. So the view configuration will always start with the default view.

Several parameter view screens can be open with different configurations by changing the configuration on the parameter list screen (F9 or Open), then opening a new Parameter View.

**NOTE**
Only one of the parameter view screens can be monitoring the controller at once.

---

**Configure Menu**

**Configure Serial Port**

This command allows you to designate the proper COM port for your PC to enable communication between the ACT and the DSS-2 controller.

**To Configure the Serial Port:**

1. From the main menu screen, choose Configure ➔ Custom Serial Port. The application will display the following screen:

2. Choose a port and click OK. This screen will be displayed on application startup if a controller cannot be found at the last selected port and can be changed any time after the application has started.

**Demo Mode**

This mode will use a calibration file “Demo.000” and use random numbers for values requested from the controller.

**COM 1 / COM 2**

This mode will look for a controller attached to the selected serial port. An error message will be displayed AFTER you click OK if a controller cannot be found or if the port cannot be opened.

COM ports outside of this range can be used by editing the default COM port registry key for this application.
Help Menu

The Help Menu provides access to the online user’s manual and other information helpful to your use of the calibration tool. The following commands are available under the Help Menu:

- Help Topics
- About ACT
- User Manuals

Help Topics

This command allows you to search for specific information by displaying software menu items or through key words.

1. Click on “Contents” for an outline of the software applications listed by menu items.
2. Click on “Index” or “Find” to locate a specific topic through an alphabetical listing or by typing in a word or phrase.
3. Follow the on-screen commands to page through the manual.

About ACT

This command displays the version of the calibration tool that you are currently using. This information is important for tool identification purposes and for servicing support.

User Manuals

This command accesses the User Manual, which includes comprehensive information on the DSS-2 controller, wiring diagrams, ACT software menus, and calibration parameters. The manual may be viewed online or printed for future reference.
Chapter 6. Troubleshooting

General Checklist

Please follow the checklist below to troubleshoot your DSS-2 controller.

We recommend using a digital multimeter capable of measuring frequency and duty cycle such as a Fluke 83 or Fluke 87.

1. Check battery voltage for stability and correct value. The LED will turn on for one second when the DSS-2 is first powered up.

2. Confirm that magnetic pickup output voltage is at least $2\, V_{\text{rms}}$ using the AC volt settings on voltmeter. The LED will illuminate when it senses an engine speed.

3. Confirm that the channel LEDs transition at the appropriate frequencies.

4. With the loads disconnected from DSS-2, use an ohmmeter to confirm that relays are working as expected. With no power to the relay, there should be continuity between the C and NC contacts and no continuity between C and NO contacts. With the relay energized, there should be continuity between the C and NO contacts and no continuity between C and NC contacts. Relays can be damaged due to excessive currents. Always remember to attach a suppression diode across large inductive loads.

5. Confirm that all external loads are functioning properly and continuity exists in the wiring harness.

Fault Codes

The DSS-2 controller is capable of identifying certain fault conditions and alerting the user to them. A flashing green LED indicates the fault conditions. The current fault code list is shown in Table 2. Please note the following:

1. When power is first applied to the controller, the green LED will flash just once for one second to indicate that the LED is working.

2. If there are multiple faults, the LED will flash them all in sequence. Count the flash codes to determine the fault conditions or connect the calibration tool to observe the fault conditions. (Use the “Display Faults” option under the Monitor Menu.)

3. If there are no faults, the LED will flash once at reset and from then on indicate the detection of engine speed. A continuous ON LED indicates that a valid engine speed is being sensed.

4. The controller will attempt to shut down for some faults and will not permit starting after reset with faults 4 and 16.
### Table 2. Fault Codes

<table>
<thead>
<tr>
<th>FLASH CODE</th>
<th>FAULT</th>
<th>RESPONSE</th>
<th>CAUSE</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Channel 1 Overspeed</td>
<td>Set Condition</td>
<td>Engine rpm has exceeded Channel 1 speed setpoint and CHNL_1_CONFIG.7 = 1.</td>
</tr>
<tr>
<td>2</td>
<td>Channel 2 Overspeed</td>
<td>Set Condition</td>
<td>Engine rpm has exceeded Channel 2 speed setpoint and CHNL_2_CONFIG.7 = 1.</td>
</tr>
<tr>
<td>4</td>
<td>Engine Protection</td>
<td>Set Condition</td>
<td>Engine Protection switch activated.</td>
</tr>
</tbody>
</table>
| 7          | Loss of Speed Signal  | Set Condition | Disappearance of speed signal. . .  
No speed signal within LOSS_TIME of power up  
OR  
No speed signal within AUTOCRANK_NS_TIME of autocrank.                                   |
| 8          | Overcrank              | No autocrank | There have been AUTOCRANK_MAX_TRIES attempts to start engine, and engine has not started.                                             |
| 9          | DSS-2 Uncalibrated     | No operation | Parameter PULSES_PER_REV must have a non-zero value. Enter the number of teeth per engine rev if you wish to work in units of RPM, or enter a value of 60 if you wish to work in units of Hz. |
| 10         | Channel 1 Set Pot out-of-range | Defaults to minimum speed | Consult factory.                                                                                                                      |
| 11         | Channel 2 Set Pot out-of-range | Defaults to minimum speed | Consult factory.                                                                                                                     |
| 16         | Controller unit failed | Yes         | Consult factory.                                                                                                                     |
Glossary of Technical Terms

ACT (All-purpose Calibration Tool) Software
PC software program for configuring and calibrating the DSS-2 controller

Actuator
Device that converts an electrical signal from the DSS-2 controller to an output shaft position

Cal File
File containing DSS-2 calibration data

Cal Tool Version
The version of calibration tool software in use

Calibration
Process of configuring and adjusting the controller to work with a specific application

Calibration Wizard
Interactive software guide to help you set up basic calibration and get the controller in operation quickly

Control Strategy
The version of software residing in the controller

DSS-2 (Digital Speed Switch, 2-Channel)
Two-channel speed switch developed by Woodward with both manual and computer adjustable settings

Parameter
Numerical value that helps the user calibrate the DSS-2 controller

Speed Sensor
Device such as a magnetic pickup that senses engine speed
Chapter 7. Service Options

Product Service Options

The following factory options are available for servicing Woodward equipment, based on the standard Woodward Product and Service Warranty (5-01-1205) that is in effect at the time the product is purchased from Woodward or the service is performed:

- Replacement/Exchange (24-hour service)
- Flat Rate Repair
- Flat Rate Remanufacture

If you are experiencing problems with installation or unsatisfactory performance of an installed system, the following options are available:

- Consult the troubleshooting guide in the manual.
- Contact Woodward technical assistance (see “How to Contact Woodward” later in this chapter) and discuss your problem. In most cases, your problem can be resolved over the phone. If not, you can select which course of action you wish to pursue based on the available services listed in this section.

Replacement/Exchange

Replacement/Exchange is a premium program designed for the user who is in need of immediate service. It allows you to request and receive a like-new replacement unit in minimum time (usually within 24 hours of the request), providing a suitable unit is available at the time of the request, thereby minimizing costly downtime. This is also a flat rate structured program and includes the full standard Woodward product warranty (Woodward Product and Service Warranty 5-01-1205).

This option allows you to call in the event of an unexpected outage, or in advance of a scheduled outage, to request a replacement control unit. If the unit is available at the time of the call, it can usually be shipped out within 24 hours. You replace your field control unit with the like-new replacement and return the field unit to the Woodward facility as explained below (see “Returning Equipment for Repair” later in this chapter).

Charges for the Replacement/Exchange service are based on a flat rate plus shipping expenses. You are invoiced the flat rate replacement/exchange charge plus a core charge at the time the replacement unit is shipped. If the core (field unit) is returned to Woodward within 60 days, Woodward will issue a credit for the core charge. [The core charge is the average difference between the flat rate replacement/exchange charge and the current list price of a new unit.]

Return Shipment Authorization Label. To ensure prompt receipt of the core, and avoid additional charges, the package must be properly marked. A return authorization label is included with every Replacement/Exchange unit that leaves Woodward. The core should be repackaged and the return authorization label affixed to the outside of the package. Without the authorization label, receipt of the returned core could be delayed and cause additional charges to be applied.
Flat Rate Repair

Flat Rate Repair is available for the majority of standard products in the field. This program offers you repair service for your products with the advantage of knowing in advance what the cost will be. All repair work carries the standard Woodward service warranty (Woodward Product and Service Warranty 5-01-1205) on replaced parts and labor.

Flat Rate Remanufacture

Flat Rate Remanufacture is very similar to the Flat Rate Repair option with the exception that the unit will be returned to you in “like-new” condition and carry with it the full standard Woodward product warranty (Woodward Product and Service Warranty 5-01-1205). This option is applicable to mechanical products only.

Returning Equipment for Repair

If a control (or any part of an electronic control) is to be returned to Woodward for repair, please contact Woodward in advance to obtain a Return Authorization Number. When shipping the item(s), attach a tag with the following information:

- name and location where the control is installed;
- name and phone number of contact person;
- complete Woodward part number(s) and serial number(s);
- description of the problem;
- instructions describing the desired type of repair.

CAUTION

To prevent damage to electronic components caused by improper handling, read and observe the precautions in Woodward manual 82715, Guide for Handling and Protection of Electronic Controls, Printed Circuit Boards, and Modules.

Packing a Control

Use the following materials when returning a complete control:

- protective caps on any connectors;
- antistatic protective bags on all electronic modules;
- packing materials that will not damage the surface of the unit;
- at least 100 mm (4 inches) of tightly packed, industry-approved packing material;
- a packing carton with double walls;
- a strong tape around the outside of the carton for increased strength.
Return Authorization Number

When returning equipment to Woodward, please telephone and ask for the Customer Service Department [1 (800) 523-2831 in North America or +1 (970) 482-5811]. They will help expedite the processing of your order through our distributors or local service facility. To expedite the repair process, contact Woodward in advance to obtain a Return Authorization Number, and arrange for issue of a purchase order for the item(s) to be repaired. No work can be started until a purchase order is received.

NOTE
We highly recommend that you make arrangement in advance for return shipments. Contact a Woodward customer service representative at 1 (800) 523-2831 in North America or +1 (970) 482-5811 for instructions and for a Return Authorization Number.

Replacement Parts

When ordering replacement parts for controls, include the following information:
- the part number(s) (XXXX-XXXX) that is on the enclosure nameplate;
- the unit serial number, which is also on the nameplate.

How to Contact Woodward

In North America use the following address when shipping or corresponding:
Woodward Governor Company
PO Box 1519
1000 East Drake Rd
Fort Collins CO 80522-1519, USA

Telephone—+1 (970) 482-5811 (24 hours a day)
Toll-free Phone (in North America)—1 (800) 523-2831
Fax—+1 (970) 498-3058

For assistance outside North America, call one of the following international Woodward facilities to obtain the address and phone number of the facility nearest your location where you will be able to get information and service.

<table>
<thead>
<tr>
<th>Facility</th>
<th>Phone Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brazil</td>
<td>+55 (19) 3708 4800</td>
</tr>
<tr>
<td>India</td>
<td>+91 (129) 230 7111</td>
</tr>
<tr>
<td>Japan</td>
<td>+81 (476) 93-4661</td>
</tr>
<tr>
<td>The Netherlands</td>
<td>+31 (23) 5661111</td>
</tr>
</tbody>
</table>

You can also contact the Woodward Customer Service Department or consult our worldwide directory on Woodward’s website (www.woodward.com) for the name of your nearest Woodward distributor or service facility.
Engineering Services

Woodward Industrial Controls Engineering Services offers the following after-sales support for Woodward products. For these services, you can contact us by telephone, by email, or through the Woodward website.

- Technical Support
- Product Training
- Field Service

Contact information:
  Telephone—+1 (970) 482-5811
  Toll-free Phone (in North America)—1 (800) 523-2831
  Email—icinfo@woodward.com
  Website—www.woodward.com

**Technical Support** is available through our many worldwide locations or our authorized distributors, depending upon the product. This service can assist you with technical questions or problem solving during normal business hours. Emergency assistance is also available during non-business hours by phoning our toll-free number and stating the urgency of your problem. For technical support, please contact us via telephone, email us, or use our website and reference Customer Services and then Technical Support.

**Product Training** is available at many of our worldwide locations (standard classes). We also offer customized classes, which can be tailored to your needs and can be held at one of our locations or at your site. This training, conducted by experienced personnel, will assure that you will be able to maintain system reliability and availability. For information concerning training, please contact us via telephone, email us, or use our website and reference Customer Services and then Product Training.

**Field Service** engineering on-site support is available, depending on the product and location, from one of our many worldwide locations or from one of our authorized distributors. The field engineers are experienced both on Woodward products as well as on much of the non-Woodward equipment with which our products interface. For field service engineering assistance, please contact us via telephone, email us, or use our website and reference Customer Services and then Technical Support.
Technical Assistance

If you need to telephone for technical assistance, you will need to provide the following information. Please write it down here before phoning:

**General**
Your Name
Site Location
Phone Number
Fax Number

**Prime Mover Information**
Engine/Turbine Model Number
Manufacturer
Number of Cylinders (if applicable)
Type of Fuel (gas, gaseous, steam, etc)
Rating
Application

**Control/Governor Information**
Please list all Woodward governors, actuators, and electronic controls in your system:

<table>
<thead>
<tr>
<th>Woodward Part Number and Revision Letter</th>
<th>Control Description or Governor Type</th>
<th>Serial Number</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*If you have an electronic or programmable control, please have the adjustment setting positions or the menu settings written down and with you at the time of the call.*